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Introduction 

 
Purpose This document describes how to install and use the Learner Information Suite 

(LIS) version 15.01.  

  
Background The LIS is a part of the LSC’s data capture systems that enable efficient 

collection and management of learner information. Other parts include: 
• Provider Batch 
• Provider On-line 
• Learning Aim Database (LAD). 
 
The LIS is designed for use by Provider Batch users. 
 
LIS 15.01 is used to validate individualised learner record (ILR) data for 
15.01, calculate derived variables, calculate Further Education (FE) funding 
data and Train to Gain (TtG) funding data, run reports against this data and 
perform reconciliation between two ILR files. The LIS also exports valid data, 
reports and reconciliation lists for transmission to the LSC through the 
Provider Batch online data collection portal.  
 
Further help is available on the LSC website: 
• the ILR (including the validation rules used by the LIS) is documented at: 

www.lsc.gov.uk/providers/data/datacollection/ILR 
• LIS 15 documentation (including a Quick Reference) is available at:  

www.lsc.gov.uk/providers/data/software/LIS/LIS15-01 

 
Previous 
Versions 

LIS series 15 can co-exist with earlier series of the LIS. It can therefore be 
installed on a PC which already has LIS 14 (or 13 or 12) installed. If you have 
an earlier version of LIS series 15 installed on your PC, it is recommended 
that you uninstall it first. 
 
LIS series 15 is designed for use with 15.01 ILR data for WBL, FE, ACL, ESF 
SR and UFI providers. Providers should continue to use series 14 for 
processing their 2006/07 ILR returns. 
 
Warning: It is advisable not to remove the shared files when uninstalling 
some old versions of LIS. 

 
Support 
Materials 

For support: 
• check the LIS section of the LSC’s website: 

www.lsc.gov.uk/providers/data/software/LIS 
• contact your local LSC. 

 

http://www.lsc.gov.uk/providers/data/datacollection/ILR�
http://www.lsc.gov.uk/providers/data/software/LIS/LIS14-03�
http://www.lsc.gov.uk/providers/data/software/LIS�
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Installing LIS 

 
Overview The LIS installation files are available for download from the LSC website 

(www.lsc.gov.uk/providers/data/software/LIS/LIS15-01). 
 
The software should be installed onto a PC matching at least the minimum 
specification required (see below). 

 
System 
Requirements 

The LIS is supported on the following operating systems: 
 
• Windows 2000 
• Windows XP Home or Professional 
• Windows Vista 
 
The PC should ideally support an internet connection, to enable you to check 
the LSC website for updates, and to download the Learning Aim Database 
(LAD). 
 
Note: You must have administrator rights on the PC, if required by your 
operating system, in order to install the software. 

 
Downloading 
LIS for 
Installation 

The installation files are located on the LSC website for you to download, 
unzip and install onto your PC. To download the files: 

 
Step Action 

1 Launch your internet browser and navigate to the LIS section of 
the LSC website: www.lsc.gov.uk/providers/data/software/LIS 
 
The page has links to the latest version for each teaching year, 
and also to all previous versions for each teaching year.  

2 If LIS 15.01 is the latest version for 15.01, choose Latest 15.01 
LIS. Otherwise choose All 15.01 LIS and then LIS 15.01 software. 
 
The LIS 15.01 page displays. It gives access to useful information 
about the software and is updated as new issues arise. 

3 Choose the full installation by clicking on the zip file download.  
 
The file download dialogue box displays. 

Continued on next page 

http://www.lsc.gov.uk/providers/data/software/LIS/LIS14-03�
http://www.lsc.gov.uk/providers/data/software/LIS�
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Installing LIS, Continued 

 
Step Action 

4 Select the option to Save this program to disk. 
 
Click OK. 

5 Select the destination directory for the download on your PC. 
 
Click Save. 
 
The file will download to your PC in the location specified. The 
download progress displays. 

 
Running the 
LIS Installation 

To be able to run the installation program you must have administrator rights 
on your PC. 
 
The software should only be installed onto the hard disk of a PC and not a 
network drive. It is recommended that you close down all other applications 
before beginning the installation process. 
 
Important:  When the software has been installed on a Microsoft Vista 
machine, the software should be run once whilst the administrator rights are 
in operation.  Otherwise the software will not work when standard user rights 
are restored. 
 
To run the installation: 

 
Step Action 

1 Unzip the downloaded LIS file and navigate to the location. 
 
Double click the file setup.exe. 
 
The Preparing to Install screen displays. 
 
Cancel stops the installation programme. 
 
Once the Preparing to Install screen is complete, the Welcome 
screen appears. 

2 Click Next.  
 
The Choose Destination Location dialogue box displays. 

Continued on next page 
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Installing LIS, Continued 

  
Step Action 

3 Use the table below to help decide: 
  IF… THEN…  
  You click 

Browse 
The Choose Folder dialogue box displays.  
Select the required location for the 
installation. Click OK. 
Cancel will cancel the selected location 
and maintain the default setting. 
Go to step 4. 

 

  You click Back You return to the previous Welcome 
screen as in step 1. 

 

  You click Next The Setup Status screen displays. Go to 
step 5. 

 

  You click 
Cancel 

You will exit the installation programme. 
Please refer to Cancelling the LIS 
Installation (see page 9). 

 

     
4 Click Next. The installation begins and the setup status screen 

displays. 
5 You may be required to restart your PC once the installation is 

complete. Click the radio button to select the option required. 
 
Note: If you are prompted to restart your computer after the 
software installation, it is recommended that you do so, to ensure 
the application will work correctly. Whether the prompt displays or 
not depends on your PC configuration. 

6 Click Finish. The installation is complete. A shortcut icon is now 
present on the desktop.  
 
The software is also accessible from the Start | Programs list. 

 
Cancelling the 
LIS Installation 

You can cancel the installation if required, during steps 1 to 4 of the Running 
the LIS Installation procedure (see page 8). 
 
To cancel the installation: 

 
Step Action 

1 Click Cancel. The Exit Setup dialogue box displays. 
2 Click a button: 
  IF… THEN…  
  You click Yes The setup programme closes.  
  You click No The installation programme returns to the 

point when Cancel was clicked and 
continues the installation. 
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Uninstalling LIS 

  
Overview LIS has a facility to allow you to uninstall the software easily. You can begin 

the un-installation process in a number of ways: 
• use the Uninstall shortcut from the Start menu 
• run setup.exe from the installation folder. 

 
Uninstall from 
the Start Menu 

To uninstall LIS 15.01 from your PC using the Uninstall shortcut: 

 
Step Action 

1 Select the Uninstall LIS 15.01 shortcut from Start | Programs | 
Learner Information Suite | LIS Maintenance | Uninstall 
v15.01.  
 
The Uninstall message appears. 

2 Click a button: 
  IF... THEN…  
  You click Yes Go to step 3.  
  You click No The uninstall program terminates.  

3 The uninstall program runs. Cancel exits the program. When 
complete, the box closes and LIS 15.01 is uninstalled. 

 
Uninstall using 
Setup 

To uninstall LIS 15.01 from your PC using setup.exe: 

 
 Step Action 

1 Navigate to the setup.exe file used to install LIS 15.01 on your 
PC and double-click the file.  
 
The Preparing to Install screen appears. Cancel will exit the 
program. Once completed, the Welcome screen displays. 

2 Select the Remove radio button and click Next.  
 
The Confirm Uninstall dialogue box displays. 

3 Click a button: 
  IF… THEN…  
  You click OK Go to step 4.  
  You click Cancel You return to the Welcome 

screen as in step 1. 
 

4 The Setup Status window appears. Cancel will cancel the un-
installation of LIS 15.01. On completion, the Maintenance 
Complete screen displays. 
 
Click Finish. 
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The Learning Aim Database 

  
Overview The Learning Aim Database (LAD) is an LSC application that holds 

information on learning aims and associated funding and statistical 
information.   
 
This information is used by the LIS and other LSC systems to validate ILR 
data, calculate derived variables and calculate funding. 
 
The LAD is available to search online, or you can download an extract of LAD 
data. More information about the LAD is available from the LAD pages of the 
LSC website at www.lsc.gov.uk/providers/data/software/LAD. 

  
The LAD and 
LIS 

Because the LIS requires information from the LAD to process data, it is 
necessary to create a link between the LIS and a download from the LAD. 
 
The data in the LAD is updated frequently. Regularly download a new version 
to ensure you are working with the most current information. 

 
Downloading 
the LAD from 
the Website 

To download the latest version of the LAD: 
 

 
Step Action 

1 Browse to the LAD on the LSC provider extranet: 
http://providers.lsc.gov.uk/LAD. 

2 Click LAD Downloads in the top menu bar.  
 
The LAD downloads page displays. 

3 Click on the file you wish to download. For the LIS you will need a 
file in Microsoft Access format (.mdb) file. For LIS 15.01 you can 
download either: 
• the entire LAD, which contains information for the current 

teaching year as well as the previous two years; or 
• the LAD for 15.01. 
 
The File Download dialogue box displays. 
 
During steps 3 to 5, Cancel stops the download. 

4 Select the Save this program to disk option and click OK. 
 
The Save As dialogue box displays. 

5 You may choose to change the location and file name for saving 
to your PC. When you have completed this click Save. 
 
The download begins and the Download dialogue box displays. 

Continued on next page 

http://www.lsc.gov.uk/providers/data/software/LAD�
http://providers.lsc.gov.uk/LAD�
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The Learning Aim Database, Continued 

  
Step Action 

6 On completion of the download the Open and Open Folder 
buttons become available. 
 

  IF… THEN…  
  You click Open The file will be opened for you 

to access and unzip to a 
suitable location on your PC.  

 

  You click Open Folder The folder containing the 
downloaded LAD is opened. 

 

  You click Close The Download dialogue box is 
closed. 

 

  
You will need to unzip the LAD then link it to the LIS.  
Refer to Link to the LAD (see page 24). 
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Login to LIS 

  
Overview The LIS can be started from the Start menu or from the desktop. You will 

need to enter a password to login. 
 
By default when the software is installed onto your PC the password is set 
to password. You may need to change the password in line with your 
organisation’s security policy. 

  
Accessing LIS 
from the Start 
Menu 

To access LIS 15.01 from the Start Menu choose Start | Programs | 
Learner Information Suite v15.01 | LIS v15.01.  

  
Accessing LIS 
from the 
Desktop 

To access LIS 15.01 from your desktop, double click the LIS v15.01 icon.  
This is automatically created as a desktop shortcut during installation. 

  
Login to LIS To login to LIS: 
 

Step Action 
1 Start LIS.  

 
In the Learner Information Suite Login dialogue box type the 
password “password” (in lower case, without the quote marks) 
into the password field. 
 
Note: If the password has already been changed then use that 
password to login. 
 
If you click Cancel, the dialogue box closes and the LIS will not 
start. 

2 Click Login. 
 
This logs you into LIS and briefly displays a splash screen. The 
Welcome screen displays once the application loads. 
 
You have now logged into LIS and can use it. 

Continued on next page 
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Login to LIS, cont 

  
Changing your 
Password 

The LIS password can be changed if required.  
 
However, note that: 
• if you forget the new password, the LIS software must be uninstalled 

and then re-installed to set the password back to the default setting of 
“password” 

• each time you upgrade the LIS software the password will be re-set to 
“password”. 

 
To change the password: 

 
Step Action 

1 Start LIS.  
 
In the Learner Information Suite Login dialogue box, enter your 
current password into the password field. 

2 Click the Change checkbox. 
3 Click Login.  

 
The Change Password dialogue box appears. 

4 Enter a new password into both the New Password field and 
the Verify Password field. 
 
The new password and verify password must match. 

5 Click OK.   
  IF… THEN…  
  The passwords match Continue to step 6.  
  The passwords do not 

match 
An error message will appear. 
Click OK and go back to step 
4. 

 

6 The Welcome screen displays. The password has now been 
changed and you may start to use LIS. 
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Navigating Around LIS 

  
Overview To navigate around and access the LIS screens, you have two options: 

• menu bar 
• navigation tree. 

 
Navigation 
using the Menu 
Bar 

The LIS application menu bar allows you to move around the screens by 
selecting a menu option and then clicking the required item.  
 
All types of collection - ACL, ESF SR, FE, UFI and WBL - are accessed 
from the same menu options. The Batch Import screen allows the collection 
type to be selected as well as the collection itself (see page 21). 

   
Navigating the 
File Menu 

The following step shows the File menu option: 

 
Step Action 

1 Click File. You can also use Alt-F to access the File menu. 
 
There is only one option available, Exit. 
 
Selecting the Exit option will close the LIS. You can also use 

 in the top right hand corner of the application window to 
close the application. 

  
Navigating the 
View Menu 

The following steps show the View menu option: 

 
Step Action 

1 Click View. You can also use Alt-V to access the View menu. 
 
The following options are available: 
• ILR Data Viewer 
• FE Funding Data Viewer 
• TtG Funding Data Viewer 
 

2 Select ILR Data Viewer.  
 
The ILR Data Viewer screen displays. This screen allows you 
to: 
• search for specific learners 
• view details for a selected learner from the imported ILR 

data  
• view rule violations for the selected learner 
• link to Report Manager with the learner reference filter pre-

populated. 

Continued on next page 
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Navigating Around LIS, Continued 

 
Step Action 

3 Select FE Funding Data Viewer.  
 
The FE Funding Viewer screen displays. This screen allows 
you to view imported and calculated data by: 
• searching for specific learners 
• viewing details for a selected learner from the imported ILR 

and LAD data 
• viewing details for a selected learner from the calculated 

derived variables and FE funding data 
• viewing rule violations and calculation errors for the 

selected learner. 
4 Select TtG Funding Data Viewer.  

 
The TtG Funding Viewer screen displays. This screen allows 
you to view imported and calculated data by: 
• searching for specific learners 
• viewing details for a selected learner from the imported ILR 

and LAD data 
• viewing details for a selected learner from the calculated 

derived variables and TtG funding data 
• viewing rule violations and calculation errors for the 

selected learner. 

 
Navigating the 
Data Menu 

The following steps show the Data menu option: 

  

Step Action 
1 Click Data. You can also use Alt-D to access the Data menu. 

 
The following options are available: 
• Batch Import 
• Export ILR File 
• Calculate Funding Data 
• Calculate Derived Data 
• Reconciliation 
• Delete Reconciliation Data. 

Continued on next page 
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Navigating Around LIS, Continued 

 
Step Action 

2 Select Batch Import.  
 
The Batch Import screen displays. The Batch Import screen 
combines most of the functionality of the LIS into a single 
screen. It allows you to: 
• select the correct collection type and period 
• select a provider 
• link to the LAD 
• import ILR data 
• validate ILR data 
• calculate derived data 
• calculate FE and/or TtG funding data 
• add and delete files for import 
• export ILR data 
• export the LIS database 
• run DSAT software 
• run and print reports 
• save and load defaults 
• monitor the status of batch operations. 

3 Select Export ILR File. 
 
The Export ILR File screen displays. This screen allows you to: 
• export ILR data to a file or to floppy diskettes 
• change the export area path 
• select data type when exporting the ILR data 
• save and load defaults 

4 Select Calculate Funding Data. 
 
The Calculate Funding Data screen displays. This screen 
allows you to: 
• run the FE funding calculations on your ILR data 
• run the TtG funding calculations on your ILR data 

5 Select Calculate Derived Data. 
 
The Calculate Derived Data screen displays. This screen allows 
you to run the derived data calculations on your ILR data 

6 Select Reconciliation. 
 
The Reconciliation screen displays. This screen allows you to: 
• reconcile two ILR files to check that continuing learners 

from the earlier file are present in the later file as expected 
• export a reconciliation file for transmission to the LSC 
• run the Reconciliation report 

7 Select Delete Reconciliation Data. 
 
The Delete Reconciliation Data dialog displays. This allows you 
to delete any previous reconciliation data. 

Continued on next page 
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Navigating Around LIS, Continued 

 
Navigating the 
Reports Menu 

The following steps show the Reports menu option: 

  

Step Action 
1 Click Reports. You can also use Alt-R to access the Reports 

menu. 
 
There is only one option available, Report Manager. 

2 Select Report Manager. 
 
The Report Manager screen displays. This screen allows you 
to: 
• run reports, with filters if required 
• view the output on screen and print reports 
• export reports 
• export the LIS database / lookup tables. 

 
Navigating the 
General Menu 

The following steps show the General menu option: 

  

Step Action 
1 Click General. You can also use Alt-G to access the General 

menu.  
 
The following options will be available: 
• Validation Rules 
• Log 
• Options 
• Postcodes 

2 Select Validation Rules. 
 
The Validation Rules screen displays. This screen allows you 
to: 
• view the list of validation rules used by the LIS for validating 

ILR data 
• view detailed descriptions for rules in the list. 
 
Note: The list contains all the rules used for validation for all 
collection types. The Collections column (Colls) displays 
categories that identify the collection type the rule is applied to. 

3 Select Log. 
 
The Log screen displays. This screen enables you to view a log 
of all operations carried out by the software since the log was 
last cleared. 

Continued on next page 
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Navigating Around LIS, Continued 

 
Step Action 

4 Select Options. 
 
The Options screen displays. This screen allows you to: 
• view the status information for the imported ILR data file 
• select a provider 
• truncate the log file 
• clear any locks in the database 
• compact the database 
• update ‘provider data’ such as provider lists, postcode lists 

and TtG broker lists. 
• view import errors 
• view current version information for the LIS, LAD, provider 

list and validation rules. 
5 Select Postcodes. 

 
The Postcodes screen displays. The Postcodes screen allows 
you to: 
• search for and view the postcodes included in the LIS 
• add (insert) new postcodes 
• delete postcodes. 

 
Navigating the 
Help Menu 

The following steps show the Help menu option: 

  

Step Action 
1 Click Help.  You can also use Alt-H to access the Help menu. 

 
There is only one option available, About Learner Information 
Suite.  

2 Select About Learner Information Suite.  
 
The About Learner Information Suite screen displays. The 
About Learner Information Suite screen allows you to: 
• view LIS information 
• view system information 
• link to the LIS page in the Data area of the LSC website. 

Continued on next page 
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Navigating Around LIS, Continued 

 
Navigation 
using the 
Navigation 
Tree 

The LIS navigation tree allows you to move around the screens by 
expanding and selecting folder items representing the LIS screens.  
 
The options are the same as in the menus, except there is no entry for 
deleting reconciliation data. 

 
Step Action 

1 The navigation tree folders appear on the left hand side of the 
Welcome screen. Click on the + symbol to the left of the LIS 
15.01 folder icon to expand the navigation tree.   
 
Note: you can use the  button to close the navigation tree 
display. To restart the navigation tree you must click on the title 
bar, where the screen title displays, below the menu options. 

2 The following folders (screens) are available from the 
navigation tree: 
 
• Batch Import 
• ILR Data Viewer 
• Calculate Funding Data  
• FE Funding Viewer 
• TtG Funding Viewer 
• Calculate Derived Data 
• Export ILR File 
• Report Manager 
• Validation Rules 
• Log 
• Options 
• Postcodes 
• Reconciliation 
 
Click on the required folder. The relevant screen displays. 
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Importing and Validating ILR Data 

  
Overview You can import and/or validate ILR data from the Batch Import screen. 

 
Note: From the Batch Import screen you can choose to run many different 
operations, including importing and validating ILR data, running calculations 
and reports and exporting ILR data or the LIS database. These operations 
can be selected in various combinations. 

  
Import ILR Data 
using Batch 
Import 

To import and validate ILR data: 

 
Step Action 

1 Access the Batch Import screen: 
 

 
2 Set up the batch import as described in the following sections.  
3 Click the Start button to start the processes selected. 

 
The processes start. Status and progress are displayed. 

  IF... THEN...  
  You wish to cancel the 

process once it has started. 
Go to Cancel the 
Import/Validate Process 
(see page 31). 

 

  You receive an import error 
message.  

Go to What if the Import 
Process Aborts  
(see page 31). 

 
 

  You receive a confirmation 
that the process has 
completed successfully. 

Click OK and go to your 
required next action. 

 

     
 

Continued on next page 
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Importing and Validating ILR Data, Continued 

  
Change the 
Collection Type 

The Collection Type field in the Batch Import screen must display the code 
for the collection type being imported (FE, WBL, ACL, ESF SR, UFI): 

 
Step Action 

1 Click the drop down on the Collection Type field to list the 
collection types. 

2 Click on the collection type required to select it. 

 
Change the 
Collection 
Code 

The Collection field in the Batch Import screen must display the code for the 
collection being imported: 
 
The collection codes will be automatically displayed relevant to the 
collection type selected (for example, for FE the collection codes will be 
F01, F02, etc.)  

 
Step Action 

1 Click the drop down on the Collection field to list the collection 
codes. 
 
Note: If you selected the Collection Type code using: 
• FE, the Collection code will be prefixed with a letter F 
• WBL, the Collection code will be prefixed with a letter W 
• ACL, the Collection code will be prefixed with a letter C 
• ESF SR, the Collection code will be prefixed with a letter S 
• UFI, the Collection code will be prefixed with a letter U. 

2 Click on the collection code required to select it. 

Continued on next page 
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Importing and Validating ILR Data, Continued 

  
Change the 
Provider 

The first time you use LIS 15.01 you will need to change the Provider field to 
your specific provider number and name. 
 
Note: If you use more than one provider number for transmitting ILR data 
you must ensure the provider field displays the correct provider number and 
name for the ILR data you are importing. If the provider number does not 
match the provider reference in the ILR file name then the ILR import will 
not allow the file to be selected. 
 
Provider numbers are issued by LSC National Office – any problems should 
be referred to your local LSC office. 
 
To change the provider: 

 
Step Action 

1 Access the Batch Import screen by selecting Batch Import from 
the navigation tree. 
 
Click the Change Prov button. 
 
The Provider Selection window displays: 
 

 
 

2 To find your provider name type the first few characters of the 
name into the Find field. The list will scroll as you type until the 
provider name that matches the characters typed displays. 
 
You can also search by entering the whole provider number in the 
Find field.  
 
Alternatively you may use the vertical scroll bar to scroll to your 
provider name and number. 
 
Highlight the entry in the list. 

Continued on next page 
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Importing and Validating ILR Data, Continued 

  
Step Action 

3 Click OK. 
 
A dialogue box displays to confirm deletion of current provider data. 
 
Note: This dialogue box only displays if a previous provider was 
selected. If there was no provider selected, the prompt will not 
appear. 

4 Click a button:   
  IF… THEN…  
  You want to change the 

provider name and delete 
any data previously 
imported for another 
provider. 

Click Yes. 
You return to the Batch 
Import screen and the 
new provider name and 
number displays. 

 

  You do not want to 
change the provider name 
and delete any data 
previously imported for 
another provider.  

Click No.  
 
You return to the Batch 
Import screen and the 
provider is not changed. 

 

  
 Note: You can also change provider details from the Maintenance 

Tab of the Options screen by clicking on the Provider… button. 

 
Link to the LAD In order to validate your ILR data you must link LIS to a download from the 

LAD. Refer to The Learning Aim Database, Downloading the LAD from the 
Website section (see page 11), for details of how to download the LAD 
tables. 
 
To link LIS to the LAD complete the following steps: 

 
Step Action 

1 Access the Batch Import screen. 
 
If this is the first time you have linked to the LAD, the Learning 
Aim Database Version and Location fields will be blank, 
otherwise they will contain details for the previously linked LAD. 

2 Click the Change LAD… button 
 
The Select Learning Aim Database Path window displays. 

3 Use the explorer window to navigate to and select the directory 
that contains the most recent version of the LAD MDB. 
  
Click Open. 
 
You return to the Batch Import screen, where the Learning Aim 
Database Version and Location fields are now populated. 

Continued on next page 
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Importing and Validating ILR Data, Continued 

 
Select 
Operations 

The Select Operations area of the Batch Import screen allows you to select 
which processes to run: 
• Import ILR Data – this operation checks the ILR data file against import 

validation rules, reports on any errors and only imports the file once it 
passes all import validation checks. 

• Validate Data – this operation validates ILR data against the validation 
rules and reports any errors. However, this operation can only run when 
the ILR data file has been successfully imported into LIS. You can select 
the type of validation by checking the appropriate radio button, either All 
Validation Rules or Funding Rule Subset. 

• Calculate Derived Data – this operation performs the derived data 
calculation, which calculates statistical values for each learner that has 
passed validation. (Note that the learners do not need to be fully valid 
but must be valid according to the funding subset of the validation rules.) 
These values are calculated and stored in the LIS database. Further 
information on these values is included in the LIS Database, Derived 
Variables and Report Guidance for LIS 15.01. 

• Calculate FE Funding– this operation calculates FE funding data for 
each learner that has passed validation. (Note that the learners do not 
need to be fully valid but must be valid according to the funding subset 
of the validation rules.) Further information is included in the Guidance 
on Interpretation of Results for the FE Funding Calculations for LIS 
15.01. 

• Calculate TtG Funding – this operation calculates Train to Gain funding 
data for each learner that has passed validation. (Note that the learners 
do not need to be fully valid but must be valid according to the funding 
subset of the validation rules.) Further information is included in the LIS 
Database, Derived Variables and Report Guidance for LIS 15.01. 

 
If all the operations are selected, LIS attempts to import the ILR data file first 
and, providing there are no import errors, it then validates the data, derives 
the statistical values and calculates funding data.  
 
To select the operations to run, complete the following step: 

 
Step Action 

1 Access the Batch Import screen. 
 
Check the Select Operations box(es) for the required 
operation(s). 
 
Note: The validation and calculation operations can be run at a 
later stage if required. Select only the operations required at 
this point.  

Continued on next page 
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Importing and Validating ILR Data, Continued 

  
Add ILR Data 
File 

To add an ILR data file to import, complete the following steps: 

 
Step Action 

1 Access the Batch Import screen 
  
If this is the first time you have selected a file for import, the 
Import Area and Files selected to import fields will be blank.  
 
If a file has been imported previously, the fields will contain 
those details. They can be removed using the Delete Files 
facility as described in step 3. 
 
Click the Add Files button. The Add ILR File to Batch window 
displays. 

2 Navigate to the directory that contains the ILR file to be 
imported and select the file. 
 
If an incorrect provider, collection type or collection period have 
been selected, or if the file is not named correctly, the files will 
not be visible. 

3 Click Open. 
 
You return to the Batch Import screen and the Import Area and 
Files selected to import fields display details of the file 
selected for import. 
 
Note: If there is any ILR data already present within LIS, it will 
be deleted when the new data is imported. LIS uses a copy of 
the ILR data file you have selected – the original file is not 
affected. 
 
Once the import is completed you can delete the file(s) from the 
LIS import area by selecting them and clicking the Delete Files 
button.  

Continued on next page 
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Importing and Validating ILR Data, Continued 

 
Export ILR Using the Export Options area of the Batch Import screen you can export 

the ILR data ready for transmission to the LSC using Provider Batch. 
 
Note: The Export ILR feature will export valid ILR data ONLY and any 
invalid data WILL NOT be exported. Therefore the export file may not be a 
reflection of the full ILR data file originally imported. 
 
To export ILR data to a file for transmission to the LSC you will export the 
file to a folder on your PC. The default location displays after the Change… 
button is used. The default location is C:\LIS\Release15\1501\exports.  
 
To export your ILR data to a file: 

 
Step Action 

1 On the Batch Import screen check the Export ILR check box. 
  IF... THEN...  
  This is the first time you are 

exporting ILR data. 
The Change… button will 
activate, go to step 3. 

 

  You have previously 
exported ILR data. 

The Change… button will 
activate and the file 
directory of the last ILR 
export displays. Go to step 
2. 

 

     
2 Check the file directory displayed: 
  IF... THEN...  
  You want to change the 

directory to which the ILR 
data will be exported 

Go to step 3.  

  You want to use this 
directory for the ILR export 

Go to step 5.  

     
3 Click Change…. 

 
The Select ILR Export Path window displays. 

4 Use the explorer window to navigate to and select the directory 
for your ILR data export and click Open. 
 
You will now be returned to the Batch Import screen. 

5 The Export ILR field displays details of the directory selected 
for the ILR export. 
 
Note: You can also export to a floppy diskette if required, by 
selecting the floppy disk drive. 

6 After the batch import is complete you can view the exported 
ILR data file and transmit it to the LSC using Provider Batch. 

 

Continued on next page 
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Importing and Validating ILR Data, Continued 

 
Export DB 
(database) 

LIS provides the Export DB function to allow you to view and manipulate the 
data held within the internal LIS database.  
 
Note: This does NOT create a file that is suitable to send to the LSC. Files 
sent to the LSC must be exported using ILR Export (see page 27). 
 
To use the Export DB facility: 

 
Step Action 

1 On the Batch Import screen click the check box alongside 
Export DB. The Change button activates. 

2 Check the file directory displayed: 
  IF... THEN...  
  You want to change 

the directory to which 
the database is to be 
exported 

Go to step 3.  

  You want to use this  
directory for the 
database export 

Go to step 5.  

  
3 Click Change… 

 
The Select Database Export Path window displays. 

4 Select the directory for your database export and click Open. 
 
You return to the Batch Import screen. The Export DB field 
details the location of the database export. 

5 Select the export format by using the drop-down list next to 
the required format. 
 
Once the import/validate process is run you are able to view 
the data by opening the file from the directory selected in  
step 4. 

 

Continued on next page 
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Importing and Validating ILR Data, Continued 

 
Running DSAT When you export the LIS database as an Access database file you can 

automatically run DSAT (Data Self-assessment Toolkit) software to analyse 
the data and produce reports. You need to have the DSAT software 
installed before this operation will work. 
 
For more information on the DSAT software refer to the DSAT page of the 
LSC website (www.lsc.gov.uk/providers/data/software/DSAT). 
 
To run DSAT after exporting the LIS database: 

 
Step Action 

1 On the Batch Import screen click the DSAT checkbox.  
 
Note: This option is only available when the Export DB option 
is selected and the export DB Format is Access 97 (MDB). 

2 Check the file directory displayed: 
  IF... THEN...  
  You want to change 

the directory where 
LIS will look for the 
DSAT software 

Go to step 3.  

  You want to use this  
directory 

Go to step 5.  

  
3 Click Change… 

 
The Select DSAT Path window displays. 

4 Select the directory where DSAT is located and click Open. 
 
You return to the Batch Import screen.  

5 The DSAT field details the location of the DSAT software.  
 
Once the Batch Import is complete DSAT will open 
automatically and load the exported LIS database. 

 

Continued on next page 
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Importing and Validating ILR Data, Continued 

 
Select Reports The Select Reports area of the Batch Import screen allows you to select up 

to four reports to be automatically produced when the batch process is run. 
Refer to the Running Reports section (see page 43) for a list of available 
reports and their descriptions. 
 
You can choose to print the reports or save them in one of several formats. 
 
Note: Reports run from Batch Import with the Format set to ‘Print’ are output 
directly to a printer. Because of the length of the reports that may be 
produced, it is recommended that you only print the Rule Violations 
Summary reports or fixed length reports, such as the Funding Claim Report, 
from the Batch Import screen.  
 
To select which reports to produce: 

 
Step Action 

1 On the Batch Import screen, click the drop down arrow next 
to the first of the Select Reports fields.  
 
The list of available reports displays. 

2 Click on the required report.  
 
The selected report displays in the Select Reports field. 

3 Repeat steps 1 and 2 for additional reports required (up to 
four). 

4 Click the drop down arrow next to the Format field.  
 
The list of available formats displays.  

5 Click on the required format.  
 

  IF... THEN...  
  You select ‘Print’ The report(s) will be sent 

directly to the default 
printer. 

 

  You select a format 
that is not ‘Print’ 

Click the Change button 
next to the Path field.  
 
Browse to the directory 
where the report(s) should 
be saved. 
 
Click Open. 

 

  
 

Continued on next page 
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Importing and Validating ILR Data, Continued 

 
Saving 
Defaults 

The Save Defaults button allows you to save the selections made on the 
Batch Import screen (and other screens where it appears). 
 
If you wish to save your selections as defaults, click Save Defaults. 
 
Note: You can overwrite default selections. The next time that you click 
Save Defaults it will overwrite existing defaults with the new selections. 

 
Loading 
Defaults 

The Load Defaults button allows you to recall previously saved defaults. 
 
Click the Load Defaults button to recall the defaults. The Batch Import 
screen displays with defaults loaded. 

 
Cancel the 
Import/Validate 
Process 

Click the Cancel button to cancel the process at any time while it is running. 
 
Note: Before the process is started, and after it has run, the button is de-
activated. 

 
What if the 
Import Process 
Aborts 

The import process will fail if the file does not meet the requirements of the 
import validation rules, for example: 
• The transmission number in the header does not match the transmission 

number in the filename. 
• The provider number in the footer does not match the provider number 

in the filename. 
 
If you receive an import error dialogue box, complete the following steps: 

 
Step Action 

1 Take a note of the error message and click OK. 
 
A second dialogue box displays explaining that the batch 
process has been aborted. 

2 Click OK. 
 
You return to the Batch Import screen. 

3 Use LIS reports to obtain details of the error. Refer to Running 
Reports (see page 43). 

4 Correct the error in your local MIS and import a new ILR data 
file. Refer to Importing and Validating ILR Data (see page 26). 

Continued on next page 
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Importing and Validating ILR Data, Continued 

 
Check the 
Results of the 
Selected 
Operations 

Once you have run the process you are able to check the results of the 
operations you selected (if required).  

 
Step Action 

1 Access the Log screen. 
 
View the results of your selected operations. The most recent 
are at the bottom of the list. Use the vertical scroll bar if 
required. 
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Viewing ILR Data 

  
Overview Although you cannot amend any ILR data from within the LIS you can still 

view the data and search for learner information.  

   
Viewing ILR 
Data 

You can view the imported ILR data using the ILR Data Viewer screen 
within LIS. 
 
To view imported data: 

 
Step Action 

1 Access the ILR Data Viewer screen. 
 
Note: No ILR data is visible at this stage.  
 
Refer to: 
• Listing All Learner Records (see below) 
• Searching for Learner Records (see page 34). 

 
Listing All 
Learner 
Records 

To list all the learner records from the ILR Data Viewer screen: 

 
Step Action 

1 
Click on the All Records icon  to list all records. 
 
A list displays on the Learners tab. The list will show all 
imported ILR learner records for you to view. 
 
Note: If you have more than 100 learner records, only the first 
100 will display. A message displays to advise you of this fact. 
Click on OK to proceed. 
 
You can move through the list using the navigation buttons. A 
scroll bar is available if all the records are not visible. 
 
Note: When you are at the start or the end of the list some of 
the navigation buttons will be active or inactive accordingly. 
 
You should search by surname or learner reference to return 
more specific results (see below). 

2 Click on a learner in the list. 
 
You will be able to view the details for the selected learner in 
the header fields and tab sections of the ILR Data Viewer 
screen. Refer to Viewing Learner Details (see page 34). 

Continued on next page 
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Viewing ILR Data, cont 

 
Searching for 
Learner 
Records 

You can search for specific imported ILR learner records if required. When 
using search within LIS you can use wildcards. * and % will enable you to 
search using partial information. ? can be used to represent individual 
characters when searching using partial information.  
 
To search for specific ILR learner records: 

 
Step Action 

1 From the Enter Search Text area, use the drop down to select a 
search type as either Surname or Learner Ref. 

2 Enter a surname or learner reference into the Enter Search 
Text field, using wildcards if required. 

3 
Click  to start the search. 

  IF... THEN...  
  A match is found The result will be shown in the list. 

 
The search results will display the 
number of records matched and 
listed. The search is complete. 

 

  No match is found An error message displays. 
 
Go to step 4. 

 

     
4 Click OK and check your search text.  
5 Enter a valid search text using steps 1 to 3 as above. 

 
 
Viewing 
Learner Details 

When a learner has been selected from the list, or by using the search 
facility, it is possible to view details for the learner, any associated learning 
aims and rule violations. This is done using the different tab sections of the 
ILR Data Viewer screen. There are two levels of ‘tabs’ and also a header 
section showing key information for the selected learner.  
 
Note: For information about the ILR data fields and the validation rules 
applied by LIS, please refer to the ILR section of the LSC website at 
www.lsc.gov.uk/providers/data/datacollection/ILR 
 
To navigate around the ILR Data Viewer: 

Continued on next page 
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Viewing ILR Data, Continued 

 
 

Step Action 
1 Click on one of the top level data tabs: 

 

 
 
The options available are: 
• Learners 
• Aims & ESF 
• Aims & HE 
• Rule Violations. 
 
For each data field displayed, to see a description of the field 
move the mouse over the field label. 
 
Once one of the tabs has been selected, a sub-set of tabs is 
available allowing more data to be viewed. 

  IF... THEN...  
  You click on the Learner 

tab: 
The following options are 
available:  
• Learner Records 
• Learner Details 1 
• Learner Details 2 
• Learner Details 3. 

 

  You click on the Aims and 
ESF tab: 

The following options are 
available: 
• Aims/ESF Records 
• Aim Details 1 
• Aim Details 2 
• Aim Details 3 
• ESF Details 1 
• ESF Details 2 
• ESF Details 3. 

 

  You click on the Aims & HE 
tab: 

The following options are 
available: 
• Aim/HE Records 
• Aim Details 1 
• Aim Details 2 
• Aim Details 3 
• HE Details 1 
• HE Details 2. 

 

  You click on the Rule 
Violations tab: 

The Rule Violations screen 
displays. 
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Deriving Data 

 
Overview LIS 15.01 contains the derived data calculations. Derived data (derived 

variables) are calculated for several reasons: 
• They are used by the LIS in the preparation of reports and for the 

funding calculations. 
• They allow consistency of definitions between local LSC offices and 

providers. 
• Providers can use the derived variables for their own reporting 

purposes. 
 
Only valid learners are passed to this module. FE, UFI and WBL learners 
can be validated against the funding subset of the validation rules. All other 
learner types must be fully validated. 
 

 
Calculating 
Derived Data 

To run the derived data calculations: 

 
Step Action 

1 Access the Calculate Derived Data screen. 
 
Click Derive Data to run the derived data calculation. 
 
Cancel will stop the calculation while it is in progress. 
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Calculating Funding Data 

  
Overview The funding calculations allow:  

• UFI and FE providers to calculate the FE funding generated by their ILR 
data, based upon their validated ILR returns 

• WBL providers to calculate the TtG funding generated by their ILR data, 
based upon their validated ILR returns 

• the LSC to use the same algorithms as providers to calculate FE and TtG 
funding based on the ILR returns transmitted throughout the year. 

 
You can run the funding calculations using either: 
• Batch Import screen 
• Calculate Funding Data screen. 
 
The FE funding calculation option is not available for ACL, ESF SR or WBL 
files. The TtG funding calculation option is not available for FE, ACL, ESF SR 
or UFI files. 
 
Before calculating funding, ILR data must be imported and validated. The 
funding calculation module uses learners that pass the funding rule subset of 
the validation rules, regardless of the type of validation chosen.   
 
To run the funding calculations from the Batch Import screen, refer to Using 
Batch Import, page 21. Using the Calculate Funding Data screen is described 
below.  
 
Note: When calculating funding within LIS, ensure you are using the latest 
provider data tables. The provider data tables contain funding factors, Long 
Term Residential Statuses and TtG broker details.  Provider data updates are 
available to download from the LSC website’s LIS page. To update provider 
data tables using the downloaded file, refer to Updating LIS Data (see 
Maintaining LIS Options page 64). 
 
Differences in funding calculation results between LIS and Online Data 
Capture usually arise due to one of the following situations: 
• Changes to the LAD between the live LAD (used by Online Data Capture) 

and the downloaded version linked to the local LIS. 
• The version of the LIS being used locally is not the most recent for the 

teaching year. 
• The LIS calculates funding for all learners who are funding rule valid. 

Provider Batch only calculates funding for fully-valid learners. 
• The ILR file run through LIS is different from the file sent to the portal. 

Continued on next page 
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Calculating Funding Data, Continued 

  
Calculating 
Funding 

To calculate funding, first import and validate your ILR data file, then 
complete the funding calculation: 

 
Step Action 

1 Access the Calculate Funding Data screen.  
2 Click Calculate FE or Calculate TtG. The LIS runs the funding 

calculations by: 
 
• Exporting learner and aim 

data 
• Exporting calculations, 

lookups and census dates 
• Calculating funding 

• Importing calculation 
results 

• Importing calculation steps 
• Importing calculation 

errors. 
 
Click Cancel to abort the calculation. On successfully completing 
the calculations a confirmation message displays. 

3 Click OK. The calculations are complete. 
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Viewing Funding Data 

  
Overview There are several ways to view the results of the funding calculation: 

 
• Use the FE or TtG Funding Viewer 
• Run funding reports 
• Examine the funding tables in an export of the LIS database. 
  
There are various funding reports to choose from that show different 
summaries of funding data. They are described in the Running Reports 
section (see page 43). 
 
The funding data tables are described in the LIS Database, Derived 
Variables and Report Guidance. 
 

 
Listing All 
Funding Data 

You can list the funding data for all imported learners. 
 
To list all the data from the FE or TtG Funding Viewer screen: 

 
Step Action 

1 Access the Funding Viewer screen (either FE or TtG). 
 
No learner data is visible at this stage. 

2 
Click on the All Records icon  to list all records. 
 
A list displays on the Learners tab and shows the first 100 
imported learner records for you to view. Move through the list 
using the navigation buttons. 
 
Use the filter for learner surname and learner reference to return 
specific results (see below). 

3 Click on a learner in the list. 
 
View the details for the selected learner in the header fields and 
in the tab sections of the Funding Viewer screen. Refer to 
Viewing Funding Data, page 40. 

Continued on next page 
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Viewing Funding Data, Continued 

 
Searching for a 
Learner’s 
Funding Data 

You can search for funding data for a specific learner if required. When 
using search within LIS you can use wildcards. * will enable you to search 
using partial information. ? can be used to represent individual characters 
when searching using partial information.  
 
To search for the funding data for a specific learner: 

 
Step Action 

1 From the Enter Search Text area, use the drop down to select a 
search type as either Surname or Learner Reference. 

2 Enter a surname or learner reference into the Enter Search Text 
field, using wildcards if required. 

3 Click the magnifying glass to start the search. 
  IF... THEN...  
  A match is found The result shows in the list. 

 
The search results display the number 
of records matched and listed.  The 
search is complete. 

 

  No match is found An error message displays. 
Go to step 4. 

 

4 Click OK and check your search text.  
5 Enter a valid search text using steps 1 to 3 as above. 

 
Viewing 
Funding Data 

The Funding Viewer screen has a series of tabs, with different sub-sets of 
data. The tabs available depend on which Funding Viewer is used (FE or 
TtG). Key information is displayed in the header section. All information is 
read-only. 
 
To navigate around the Funding Viewer screen: 

 
Step Action 

1 Click on one of the tabs: 
• Learners 
• Aims 
• LAD Lookups 
• Derived – FE only 
• Funding 
• Funding (No Disadvantage) – FE only 
• Calculation Steps 
• Errors 
 
Once a tab has been selected, a further subset of tabs allows 
more data to be viewed. 

Continued on next page 
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Viewing Funding Data, Continued 

 
Step Action 

     
  IF… THEN…  
  You click on the 

Learners tab 
A list of learner records is 
available. 

 

  You click on the Aims 
tab 

Aim details for the selected 
learner are available. 

 

  You click on the LAD 
Lookups tab 

Funding details from the LAD 
about the learning aims are 
available. 

 

  You click on the Derived 
tab – only available on 
the FE Funding Viewer 

The following options are 
available: 
• Base (Initial): This data is 

taken from A52 for distance, 
e-learning, or NVQ in the 
workplace aims; the relevant 
National Base Rate field from 
the LAD for listed aims; or the 
relevant band based on 
guided learning hours for 
loadbanded aims. 

• Base (Tapered/Scaled): The 
aim’s National Base Rate 
after any tapering or 
traditional ESF (see fields A11 
and A12) scaling. 

• Base (Weighted): The 
tapered, scaled national base 
rate, including Area Cost 
Factor, Disadvantage Factor, 
Programme Weighting Factor, 
Performance Related Factor 
and Specialist College Factor. 

• Fee Element: 37.5% of Base 
(Initial). 

• Franch Disc: Any applicable 
rate discount for franchising. 

• Taper Factor: The amount by 
which the national base rate is 
tapered for each aim for each 
period. 

 

Continued on next page 
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Viewing Funding Data, Continued 

 
Step Action 

     
  IF… THEN…  

  You click on the Funding 
tab in the FE Funding 
Viewer 

The following values are given: 
• Prog Funding: The Weighted 

Base Rate with achievement 
element, fee element, and 
franchise discount removed. 

• Achievement: The 
programme funding for the 
period multiplied by the 
provider’s achievement 
factor. 

• Fee Remission: 37.5% of 
the initial national base rate. 

• Additional Support: The 
value, divided per aim per 
period, of the band that the 
learner’s additional support 
cost falls into. 

• Totals 

 

  You click on the Funding 
tab in the TtG Funding 
Viewer 

The following values are given: 
• Start Funding: assigned 

when the learner started 
their aim (50% of the TtG 
rate x weighting factors). 

• Achievement Funding: 
assigned when a learner 
achieves (50% of the TtG 
rate x weighting factors). 

• Totals. 

 

  You click on the Funding 
(No Disadvantage) tab - 
only available on the FE 
Funding Viewer 

This screen displays funding 
values with programme and 
achievement funding calculated 
without the disadvantage uplift. 
• Programme 
• Programme (No Disadv.) 
• Achievement 
• Achievement (No Disadv.) 
• Fee Remission 
• Additional Support 
• Totals. 

 

  You click on the 
Calculation Steps tab 

This screen shows the steps in 
the funding calculation for the 
learner selected. 

 

  You click on the Errors 
tab 

This screen shows any Rule 
Violations or Calculation Errors 
for the learner selected. 
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Running Reports 

  
Overview You can run reports from the: 

• Batch Import screen 
• Report Manager screen. 
 
For running reports from the Batch Import screen refer to Importing and 
Validating ILR Data, Select Reports (see page 30). 
 
The Batch Import screen will output reports directly to a printer, whereas the 
Report Manager screen will output to a window for viewing, printing or 
exporting.  
 
Validation reports are available for all collection types. FE funding reports are 
only available for FE and UFI collection types. TtG funding reports are only 
available for the WBL collection type. 

 
Available 
Reports – 
validation 

• The Rule Violations report – lists any ILR rule violations produced during 
the validation process. 

• The Rule Violations by LSC report – lists any ILR rule violations 
produced during the validation process, grouped by local LSC. 

• The Rule Violations Summary report – will output, for each validation 
error generated during the validation process, a count of the number of 
instances found in the ILR data. 

• The Rule Violations Summary by LSC report – will output, for each 
validation error generated during the validation process, a count of the 
number of instances found in the ILR data, grouped by local LSC. 

• The Full ILR Validation Rules report – lists all ILR validation rules used 
by the LIS. 

 
All violations reports include a summary box which details the total number of 
data records, the total number of invalid and valid learners according to rule 
type (full or funding-only) and a count of the aims for each funding stream 
value, except TtG which is included in ‘other aims’. (This count is based on 
ILR field A10.) 

 
Available 
Reports – 
miscellaneous 

• On-Site Guided Learning Hours report – lists the on-site daytime 
expected guided learning hours, the number of learners with greater than 
1200 guided learning hours and the total learner numbers. 

• Level 2 Entitlement report – shows the number of learners taking full 
level 2 programmes of study and the numbers of learners claiming Level 
2 entitlement and gives an estimate of the number of learners who may 
be eligible to claim level 2 entitlement. This report has been designed to 
support the Level 2 Entitlement Pilot. 
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Available 
Reports – TtG 
funding 

• TtG Funding Summary report – describes the aim numbers and the 
amount of start/achievement funding for Train to Gain funded provision, 
for a selected period and the year to date. If run from Batch Import, the 
period is automatically set according to the ILR file preparation date. 

• TtG Occupancy Export report - This export report shows details for all 
aims, including aim monitoring fields, TtG funding information and other 
data that are used to create the TtG Funding Summary report.  Details 
from all aims, regardless of A10, are included. 

• Train to Gain Detailed Learner and Aim Funding report – This report 
describes the learner and aim data used to calculate TtG funding.  It is the 
TtG equivalent of the FE Details Learner and Aim Funding report – report 
number 12 in LIS. 

• Train to Gain Calculation Steps report- The Train to Gain (TtG) 
Calculation Steps report describes the steps taken when calculating TtG 
funding for learners and aims.  This report is the TtG equivalent of the FE 
Calculations Steps report – report number 10 in LIS. 

• Train to Gain Calculation Errors report - The Train to Gain (TtG) 
Calculation Errors report describes errors which have occured whilst 
calculating TtG funding for learners and aims.  This report is the TtG 
equivalent of the FE Calculations Errors report – report number 11 in LIS. 

 
 

Continued on next page 
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Running Reports, Continued 

  
Available 
Reports – FE 
funding 

• The Summary of FE Funding by Learner report summarises funding 
for every learner reference. It is advisable to use filters. 

• The Summary of FE Funding by Category report outputs the total 
funding for a provider classified by period and category. 

• The Summary of FE Funding with Disadvantage report outputs the 
total funding for a provider classified by period, category and separates 
the funding calculated purely for disadvantage uplift. 

• The FE Calculation Steps report details the steps used to calculate 
funding aim by aim for each learner. It is advisable to use filters. 

• The FE Calculation Errors report outputs a summary report for all 
funding calculation errors in the ILR file.  

• The FE Detailed Learner and Aim Funding report details funding for 
each learner by aim and period. It is advisable to use filters. 

• The Learning Aim FE Funding report provides a funding summary by 
category for every aim reference used in the ILR file and counts their 
instances. This report can be very long and should be filtered. 

• The Learning Aim Summary 1/2/3 reports provides the total funding by 
the first/second/third provider specified aim field and category.  

• The Learner Summary 3 report shows total funding by category and 
both provider-specified learner fields. 

• The FE Funding Included and Excluded by ILR Export report splits 
funding by category and period between fully valid learners, who are 
included in the ILR export, and learners who are not included. 

• Summary by Franchised Out Arrangement report splits the funding 
by category and period for each franchised out arrangement value (A21) 
used in the ILR file. 

• FE Funding by Fee Remission Category report splits the funding by 
category for each fee remission reason value (A14) used in the ILR file 
and counts the aims for each reason. 

• Additional Learning Support Funding report summarises funding for 
several ranges of calculated additional support. The report also counts 
the learner numbers in each funding range. 

• ILR FE Achievement Funding Report shows the achievement funding 
calculated using two methods: based on the programme funding and 
achievement factor, and based on the achievement data in the ILR data. 

• The FE Learner Numbers with Funding report gives totals for full and 
part time learners in each age category, and shows the funding 
generated. It is described in detail in the document LIS Database, 
Derived Variables and Report Guidance. 

• FE Funding Claim Report shows totals for full and part time learners in 
each age category and for Skills for Life, PCDL and ALS learners, and 
also shows their cash value. The report is designed to help providers 
when filling out their Final Funding Claim. It is described in detail in the 
document LIS Database, Derived Variables and Report Guidance. 

• ESF Match Within FE report – shows the number of aims with/without 
the potential to be used for ESF match funding, and the level of FE 
funding for those aims. For aims with ESF datasets the figures are 
categorised based on the learner employment status (E12). 

Continued on next page 
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Running Reports, Continued 

  
Available 
Exports 

In Report Manager two export options appear in the same list as the reports:  
• The FE and UFI Learner Export exports ILR learner data from LIS in a 

format that providers can use (for example, in Excel). The export 
includes derived variable and FE funding information (see the LIS 
Database, Derived Variables and Report Guidance for an explanation of 
these derived variables). 

• The FE and UFI Aim Export exports ILR aim data from LIS in a format 
that providers can use (for example, Excel).   

 
The content of these exports depends on the collection type of the imported 
data. All collection types except ESF SR have both learner and aim exports. 

 
Selecting and 
Running a 
Report 

The Report Manager enables you to select, run, print and export available 
reports. 
 
You can only run a single report at a time from Report Manager. If you 
would like to run multiple reports simultaneously you should use the Batch 
Import screen. 
 
To use Report Manager to select and run a report: 

 
Step Action 

1 Access the Report Manager screen. 
2 From the list of Available Reports select the one you require 

by clicking on the report. On selection the report will be 
highlighted. 
 
Note: The available filters will change in the lower area of the 
screen as you select a report from the list.  
 
For more details on filters, see Using Filters in Reports (see 
below). 

3 Click on the Run Report button. The report output displays in a 
print preview window. 
 
The toolbar at the top of the report window enables you to: 
• Zoom the view and navigate through the report pages. 
• Print or export the report output. 
 

 
 
Refer to: 
• Printing a Report (see page 50) 
• Exporting a Report (see page 51). 

Continued on next page 
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Running Reports, Continued 

  
Using Filters in 
Reports 

Filters are used to restrict the amount of data returned in the report. They 
are used when you are interested in a specific record or group of records. 
The filters vary for each report and are displayed when a report is 
highlighted in the list.  
 
There are no limitations on the number of filters you can use per report. 
However, the values used should be valid or your report output will be 
affected. It is useful to use filters when reporting on large sets of data. 
 
You may use wildcards (*, % or ?) when populating filter fields. 
 
Note: Filtered reports can also be run using the print icon from the ILR Data 
Viewer screen, which will pre-populate the filters with the information for the 
selected learner. 

 
Available 
Filters for 
Reports 

There are a number of filters available for use when running reports. The 
filters vary from report to report. The following table shows a list of reports 
which use filters, and which filters are available for each: 

 

Available Filters Report Name 
Learner 
Ref 

Rule 
Name 

Funding 
Rule 

Warning Provider 
Specified 
Learner 
Data (1) 
& (2) 

Provider 
Specified 
Aim Data 
(1) & (2) 

Error 
Code 

Learning 
Aim 
Reference 

Period 
 

LLSC 
Number 
 

Rule Violations 
(& by LSC) ●  ● ● ● ●     
Rule Violations 
Summary (& by 
LSC) 

  ● ●       
Full ILR 
Validation Rules  ● ● ●       
Summary of FE 
Funding by 
Learner 

●    ●      
FE Calculation 
Steps ●    ●      
FE Calculation 
Errors ●      ●    
FE Detailed 
Learner and Aim 
Funding 

●    ●      
Learning Aim FE 
Funding      ●  ●   
Learning Aim 
Summary 1, 2 
and 3 

    ● ●     
Learner 
Summary 3 ●    ●      
FE Funding by 
Fee Remission     ●      
Additional 
Learning Support 
Funding 

    ●      
TtG Funding 
Summary          ●  
TtG Calculation 
steps ●    ● ●    ● 
TtG Calculation 
Errors ●      ●   ● 
TtG Detailed 
Learning and 
Aim Funding 

●    ● ●    ● 
TtG Occupancy 
export          ● 

Continued on next page 
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Running Reports, Continued 

 
Recommended 
Field Values for 
Filtering 

The following table describes the valid values you can use for each of the 
filter fields in the reports: 

 
Filter Name Acceptable Value 
Learner Reference Full/partial Learner Reference Number. 
Rule Name Full/partial rule name (listed on Validation Rules screen). 
Funding Rule Can use either Y or N depending upon if you are filtering 

for an FE funding rule or not. Y returns results where the 
rule is a funding rule; N returns results where the rule is 
not a funding rule. 

Warning Can use either Y (for warnings) or N (for errors).   
Provider Specified Learner Data (1) Uses a reference number or part of one. (Refer to the 

ILR Field Specification document, which describes the 
use of this field, L42.) 

Provider Specified Learner Data (2) Uses a reference number or part of one. (Refer to the 
ILR Field Specification document, which describes the 
use of this field, L42.) 

Provider Specified Aim Data (1) Uses a reference number or part of one. 
(Refer to the ILR Field Specification document, which 
describes the use of this field, A48.) 

Provider Specified Aim Data (2) Uses a reference number or part of one. 
(Refer to the ILR Field Specification document, which 
describes the use of this field, A48.) 

Period Period 1 to 12. 
Error code Calculation error code. 
Learning Aim Reference Full/partial (using wildcards) learning aim reference. 
LLSC Number The Local LSC associated with the provider in the TtG 

Provider list in the LIS lookup tables. (Refer to the ILR 
Field Specification document, which describes the use of 
this field, L25.) 

 
Running 
Filtered 
Reports 

To use filters in your report follow the steps below: 

 
Step Action 

1 Access the Report Manager screen. 
2 Select the required report from the Available Reports list.  
3 If you want to remove all values entered in the filter fields of the 

report, click the Clear Filters button. 
4 Enter a valid value in the filter field for the filter you want to use. 

Repeat for as many filters as required.   
5 Click the Run Report button. The report output displays in a 

print preview window. 
 
The report output can now be printed or exported. Refer to 
Printing a Report (see page 50) or Exporting a Report (see 
page 51).  
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Running Reports, Continued  

 
Printing a 
Report 

You can print reports using: 
• Batch Import screen 
• Report Manager. 
 
When you choose to print reports from the Batch Import screen the report 
output is sent direct to the default printer. This should be used with caution 
as some reports are several hundred pages long. 
 
When using Report Manager the report output displays on screen first and 
then you can send the report to print if required.  
 
Reports can also be exported and printed using another application. 
Exported reports can be saved for printing at a later date. 
 
The following steps describe how to print your report from Report Manager.  

 
Step Action 

1 From Report Manager select a report, set any required filters 
and click the Run Report button.  
 
The report output displays in the print preview window. 

2 
Click Print  from the top of the report output window. The 
Print dialogue box displays. 
 
Select the printer, the print range for the number of pages to 
print, and the number of copies required and ensure the collate 
copies option is correctly set. 

3 Click OK. The report output is printed at the chosen printer. 
 
Cancel will close the print dialogue box and not print the output.

Continued on next page 
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Running Reports, Continued 

  
Exporting a 
Report 

It is possible to export report outputs to a variety of formats.  
 
To export your report output:  

 
Step Action 

1 From Report Manager select a report, set any required filters 
and click the Run Report button.  
 
The report output displays in the print preview window. 

2 
Click Export   from the top of the report output window. 
The Export dialogue box appears. 

3 Select a Format from the drop down list. The default format is 
PDF. Use the vertical scroll bar to see the whole list. 

4 Select a Destination from the drop down list. The default is to 
save the item to disk. 

5 Click OK. 
 
The Export Options dialogue box displays. 

6 Select the page range of the report you are exporting. 
 
The default is to export the whole report. 

7 Click OK. 
 
The Choose export file dialogue box displays. You may change 
the location, file name or format of the exported report if 
required. 

8 Click Save. 
 
The report will be exported to the specified location. You can 
view the report from that location by accessing the exported 
report file using Windows Explorer or an appropriate 
application. 
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Exporting ILR Data 

  
Overview This facility exports the ILR data ready for transmission to the LSC using the 

Provider Batch capture process. 
 
To export your ILR data from LIS you can use the: 
• Batch Import screen 
• Export ILR File screen. 
 
Note: The Export ILR file feature will export valid ILR data ONLY. Invalid 
records WILL NOT be exported. The export file may not be a reflection of 
the originally imported ILR data file. 
 
It is therefore important that you ONLY export the ILR data when all errors 
have been corrected and the file has been fully validated through the LIS.  
 
The Batch Import screen allows you to select an operation to export 
validated ILR data as part of the import/validate process, or separately.  
Refer to the Export ILR section of Importing and Validating ILR Data (see 
page 27). 

  
Exporting ILR 
Data using ILR 
Export 

You can export ILR data using the Export ILR File screen.  
 
There is also functionality to allow export of data to 1.44MB floppy disks. 
 
To export ILR data using the Export ILR File screen: 

 
Step Action 

1 Access the Export ILR File screen. 
 
The fields on this screen are mainly read-only. They are 
populated with information from the imported file. 

2 You may choose to change the Data Type by selecting one of 
the radio buttons. This will be set by default from the imported 
data file. 

Continued on next page 
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Exporting ILR Data, Continued 

 
  

3  
  IF... THEN...  
  You would like to export to 

a file on your PC’s hard disk
Make sure the “Export to 
Floppy Diskettes?” check 
box is not ticked. 

 

  You would like to run the 
report showing funding 
included and excluded by 
the export 

Click the Run report 
showing funding included 
and excluded by ILR 
export check box. 

 

  You would like to load 
defaults 

Click the Load defaults 
button. 

 

  You would like to save 
defaults 

Click the Save defaults 
button. 

 

  You click Cancel. 
 

The export process is 
aborted. 

 

     
     

4 Click on the Change… button to select a different Export Area. 
 
Select an Export Area path and click Open. 

5 Click on the Export button.  
 
The export begins and a confirmation prompt appears. 

6  
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Reconciliation 

  
Overview The reconciliation process ensures that where a learner studies in two or 

more successive teaching years, the learner is included in the subsequent 
year’s ILR. Reconciliation is only required for FE and UFI collection types. 
 
From two different ILR returns, the LIS identifies records for learners on the 
earlier return (for example ILR F04 or U04 for 2005/06) which are expected 
to be included on the later return (for example ILR F01 or U01 for 15.01). 
Where records are not present as expected an entry is produced on a 
reconciliation list. 
 
Different providers can be selected for each of the files input for 
reconciliation. This allows for provider number changes between teaching 
years. 
 
Reconciliation can be run for: 
• Mode F04/F01 or U04/U01 – between 2006/07 F04/U04 and 15.01 

F01/U01 files.  
• Mode F05/F01 or U05/U01 – between 2006/07 F05/U05 and 15.01 

F01/U01 files.  
 
Both produce a reconciliation file with the 15.01 provider number and dated 
07/08, ready for transmission to the LSC. 

 
Preparing to 
Reconcile your 
ILR Data 

To reconcile ILR data follow the steps below: 

 
Step Action 

1 Access the Reconciliation screen. 
2 Ensure that the Provider 1 and 2 fields display the correct 

provider number and name for the ILR data you wish to 
reconcile. 
 
Note:  If the provider number does not match the provider 
reference within the ILR file name, the reconciliation process 
will be unsuccessful. 

  IF... THEN...  
  The provider numbers and 

names are not correct 
Go to step 3 below.  

  The provider numbers and 
names are correct 

Go to step 6.  

3 Click the Change button adjacent to the Provider 1 field boxes. 
 
The Provider Selection box displays showing a list of provider 
numbers and names in alphabetical order. 

Continued on next page 
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Reconciliation, Continued 

 
Step Action 

4 To find your provider name, type the first few characters of the 
name into the Find field. The list scrolls as you type until the 
provider name matches the characters typed. 
 
You can also search by entering the whole provider number in 
the Find field. Alternatively, use the vertical scroll bar to scroll to 
your provider name and number. 
 
Highlight the entry in the list. Click OK. 

5 Click the Change button adjacent to the Provider 2 field boxes. 
 
Follow steps 3 – 4 above.  

6 Select the Mode of reconciliation: 
• F04/F01 or U04/U01 
• F05/F01 or U05/U01 

7 When selecting a file for reconciliation: 
  IF… THEN…  
  This is the first time you 

have selected a file for 
reconciliation 

The Files selected to 
reconcile fields will be 
blank. 
 
Go to step 8. 

 

  A file has been reconciled 
previously 

The fields will contain those 
details. 
 
They can be removed using 
the Delete Files facility as 
described in step 11. 

 

8 Click the Add Files… button in the Reconciliation File 1 area. 
The Select ILR file to reconcile window displays. 
 
Navigate to the directory that contains the ILR file to be 
reconciled and select the file. Only one file can be added. 
 
Note: If an incorrect provider, collection type or collection 
period have been selected, or if the file is not named correctly, 
the files will not be visible. 

9 Click Open. 
 
You return to the Reconciliation screen. The Reconciliation 
File 1 – Files selected to reconcile field displays details of the 
file selected for reconciliation. 
 
Note: Any ILR data already present within LIS will be deleted 
when the new data is imported. LIS copies the ILR data file 
selected – the original file is not affected. 

Continued on next page 
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Reconciliation, Continued 

 
Step Action 
10 Click the Add Files… button in the Reconciliation File 2 area 

and follow steps 8 – 9. 
11 You can delete the files from the Files selected to reconcile 

fields. Select the file you wish to delete. Click Delete Files and 
the file will be removed from the field. 

  
Exporting 
Reconciled 
Data  

Within the Operations area of the Reconciliation screen you have the 
facility to export the reconciled data to a location in your directory or on to 
floppy diskettes. 
 
To export the file to a folder on your PC, follow the steps below: 

 
Step Action 

1 In the Operations area of the Reconciliation screen. 
  IF... THEN...  
  You want to change the 

directory to which the 
reconciliation data exports 

Go to step 2.  

  If you want the directory for 
the reconciliation export to 
remain the same 

Go to step 4.  

2 Click Change….The Select Export File Path window displays. 
3 Use the explorer window to navigate to and select the directory 

for your reconciliation data export and click OK. 
 
You return to the Reconciliation screen and the details of the 
directory selected for the reconciliation export display. 

4 You can also export to a floppy diskette(s) if required. A disk 
must be inserted into the drive. Click the Export to floppy 
checkbox. 
 
Once the first diskette is full, LIS displays a message informing 
you how many diskettes are required to complete the export. 
 
Note: The LIS can not burn a file to CD. 

 
Reconciliation 
Report  

At the time of export you may wish to run the Reconciliation Report: 

 
Step Action 

1 Click the Reconciliation Report checkbox in the Operations 
section of the screen.  
 
The report will be output to the default printer. 

Continued on next page 
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 Reconciliation, Continued 

 
  IF... THEN...  
  No printer is available A suitable error message 

appears. Click OK to clear and 
the process will be cancelled. 

 

  The report is over 500 
entries 

A message will appear asking if 
you wish to print the report now or 
later. 

 

 The report output is stored in the LIS database and can be printed 
from the Report Manager at any time after the reconciliation has 
been performed, until a new reconciliation is run and the stored 
data replaced. 
 
For running reports from the Batch Import screen refer to Select 
Reports (see page 30). 

  
Running the 
Reconciliation 
Process  

To start the reconciliation process: 
 
 

 
Step Action 

1 Click the Reconcile button. The process starts. Status and 
progress appear. 

  IF... THEN...  
  You receive an import 

error message 
Click OK to clear. The 
reconciliation process aborts. 

 

  The process is aborted 
for any reason 

A dialogue box will appear with 
the message The Reconciliation 
process has aborted.   
 
Click OK to close the box. 

 

  LIS confirms that the 
process has completed 
successfully 

Click OK to close the box.  

 The imported data files and output data file are stored in separate 
tables in the LIS database. On subsequent reconciliation 
operations, the stored data is automatically deleted and replaced 
by the new data. 

 
Cancelling the 
Reconciliation 
Process 

Click the Cancel button to cancel the process at any time while it is running. 
Before the process is started, and after it has run, the button is de-activated. 

  
Delete 
Reconciliation 
Data 

The stored reconciliation data can be manually deleted via the Menu option 
Delete Reconciliation Data in the Data menu. 
 
Click Yes to confirm the deletion. 
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Validation Rules 

  
Overview LIS uses a set of validation rules, in conjunction with the LAD and other 

lookup data, to validate the imported ILR data. Using LIS series 15 your ILR 
data will be validated against a version of the 15.01 validation rules. 
 
You can find out which version of the validation rules are used (refer to the 
Viewing Version Information section on page 64). 
 
For details about the validation rules and the amendments since previous 
releases, please refer to the ILR pages of the LSC website: 
www.lsc.gov.uk/providers/data/datacollection/ILR 

   
Listing all 
Validation 
Rules 

It is possible to list all the validation rules applied by the LIS by accessing 
the Validation Rules screen.  
 
To list all the validation rules: 

 
Step Action 

1 Access the Validation Rules screen. 
2 Use the scroll bar to move up and down the list and view the 

rules. 

 
Viewing 
Validation Rule 
Properties 

You can view additional information for each validation rule listed in the 
Validation Rules screen.  
 
To view properties for a selected validation rule: 

  
Step Action 

1 Scroll the list to find the rule you are searching for and double 
click the rule. 
 
The Validation Rule Properties dialogue box displays. 

2 Once you are finished, click Cancel. 
 
The dialogue box closes and returns to the Validation Rules 
screen. 

 
Reports 
showing Full 
ILR Validation 
Rules  

The Full ILR Validation Rules report lists the validation rules. To run this 
report, follow the procedure described in the Running Reports section of this 
user guide (see page 43). 

 
 

http://www.lsc.gov.uk/providers/Data/Datacollection/ILR/�
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Maintaining LIS Options 

  
Overview There are several options which may need to be viewed and/or maintained 

from within the LIS. They are accessed from the Options screen.  

 
Viewing Status 
Information 

You can view status information for the data you have imported into LIS:  

 
Step Action 

1 Access the Options screen. Click on the Status Information 
tab if this is not displayed by default. 
 
The status information displays. From this screen you can view: 
• the selected provider 
• details for the most recently completed processes 
• the number of learners imported. 

2 If you want to see a list of processes that have taken place, 
click the Show History check box at the bottom of the screen. 
 
The history information displays. 

Continued on next page 
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Maintaining LIS Options, Continued 

  
Maintenance 
Options  

The Maintenance tab within Options allows you to carry out some 
maintenance tasks within LIS: 

 
Step Action 

1 Access the Options screen. Click the Maintenance tab. 
 
The Maintenance tab offers the following options: 
• Provider Selection 
• Truncate Log 
• Clear Locks 
• Compact DB 
• Update Data. 

2 Click on a button to conduct a specific operation. 
  IF... THEN...  
  You wish to change your 

provider 
Click on the Provider… 
button. Go to Change the 
Provider (see page 23). 

 

  You wish to truncate the log 
file 

Click on the Truncate Log 
button. Go to Truncating the 
Log (see page 61). 

 

  You wish to clear locks  Click on the Clear Locks 
button. Go to Clearing 
Locks (see page 62). 

 

  You wish to compact the 
database  

Click on the Compact DB 
button. Go to Compacting 
your Database (see page 
63). 

 

  You wish to update the data 
used by LIS  

Click on the Update Data 
button. Go to Updating your 
LIS Data (see page 64). 

 

     

Continued on next page 
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Maintaining LIS Options, Continued 

  
Truncating the 
Log 

The LIS application keeps a log of some of the events or operations carried 
out. Refer to Viewing the Audit Log for more information (see page 67). The 
log file is useful for diagnosing problems, but it can be truncated if required. 
Truncating the log erases all the log entries and is useful if you wish to save 
hard disk space.  
 
The following steps show how this can be achieved: 

 
Step Action 

1 Access the Options screen. Select the Maintenance tab.  
 
Click on the Truncate Log button. 
 
A warning message advises you that this process is not 
reversible.  

2 Select an option: 
  IF... THEN...  
  You click OK A confirmation message 

displays. 
The truncation is complete. 
Go to step 3. 

 

  You click No You return to the 
Maintenance tab and no 
truncation has taken place. 

 

     
3 Click OK.  

 
You return to the Maintenance tab. 

Continued on next page 
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Maintaining LIS Options, Continued 

  
Clearing Locks Locks will occur within LIS if processes remain incomplete, for example if 

your PC is switched off during an import. Error messages will prevent you 
from completing some operations. If this occurs then the Clear Locks option 
should be used: 

 
Step Action 

1 Access the Options. Select the Maintenance tab.  
 
Click on the Clear Locks button.  
 
A warning message displays advising you that this process is 
not reversible. 

2 Select an option 
  IF... THEN...  
  You click OK A confirmation message 

displays. 
Go to step 3. 

 

  You click No You return to the 
Maintenance tab screen 
and no locks have been 
cleared. 

 

     
3 Click OK.   

 
You return to the Maintenance tab screen. 

Continued on next page 
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Maintaining LIS Options, Continued 

  
Compacting 
your Database 

You can compact the database within LIS, to save hard disk space.  
However, the LIS performs self-compaction after validation so this option is 
generally only useful for providers with exceptionally large files.  
 
To compact the database: 

 
Step Action 

1 Access the Options screen. Select the Maintenance tab. 
 
Click on the Compact DB button.  
 
You will be asked to confirm that you want to compact the 
database. 

2 Select an option. 
  IF... THEN...  
  You click Yes A confirmation message 

displays. 
Go to step 3. 

 

  You click No You return to the 
Maintenance tab screen 
and the database has not 
compacted. 

 

     
3 Click OK.  

 
You return to the Maintenance tab. 

Continued on next page 
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Maintaining LIS Options, Continued 

  
Updating your 
LIS Data 

You can update static data used by the LIS, for example the Provider list 
and Postcode list. You will only need to do this when an update is released 
on the LIS pages of the LSC website. 
 
Use the following steps to update your LIS data: 

 
Step Action 

1 Download the updated data file from the LIS pages of the LSC 
website to your PC.   

2 Access the Options screen. Select the Maintenance tab. 
 
Click on the Update Data button.   

3 The Select lookups update file dialogue box displays. Select 
your data file for updating LIS. 

4 Click OK. The selected file updates data within LIS. 

 
Viewing Import 
Errors 

You can view a list of import errors that may be encountered when importing 
ILR data into LIS: 

 
Step Action 

1 Access the Options screen. Select the Import Errors tab.  
2 The import errors tab screen displays. Click on an error in the 

list for more details. 

  
Viewing 
Version 
Information 

You may need to know which version of the LIS and the LAD you are using. 
For example, this information is useful when updating software, maintaining 
data and requesting support.  
 
To view version information from within the LIS application: 

 
Step Action 

1 Access the Options screen. Click the Version Information 
tab.  
 
The version information tab screen displays. It is read only and 
shows version information for: 
• Learner Information Suite 

• Database 
• Application 
• Validation Rules 
• Provider List 

• Learning Aim Database  
• Modules  
• Funding calculation module 
• Derived data module. 

Continued on next page 
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Maintaining LIS Options, Continued 

  
Maintaining 
Postcodes 

Postcodes can be maintained from within LIS. You can search for existing 
postcodes or insert new postcodes into the list. 

 
Searching for 
Postcodes 

To search for postcodes: 

 
Step Action 

1 Access the Postcodes screen. 
 
The list shows all postcode records for you to view. Move 
through the list using the scroll bar or the navigation buttons. 

2 
If you click the drop down next to the search button  you 
have two options: 

  IF... THEN...  
  You click All Record The list is refreshed to 

display all postcode records 
within LIS. 

 

  You click Some Records. The Select Filter Required 
dialogue box displays. 
 
Go to step 3. 

 

  
3 Click on the drop down for Data Field to select a category for 

your search. 
 
Three Filter options are available: 
• Council entered 
• Description 
• Outward Postcode. 

4 Enter a value in the Filter field. 
 
Note: wildcard characters are NOT allowed. 

5 Click on the Filter button. Your search results display. 
 
Cancel will cancel the search. 

Continued on next page 
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Maintaining LIS Options, Continued 

 
Inserting New 
Postcodes 

It is possible to insert new postcodes into the list within LIS. 
 
To insert new postcodes: 

 
Step Action 

1 
Click Insert . 
 
The Postcode screen displays. 

2 Enter the Outward Postcode in the field. 
3 Enter a Description for the postcode. 

 
Note: The inserted postcode defaults Council Entered to N. 
 
The entry displays at the end of the existing list. 

4 
Click Save Changes . 
 
The new postcode is inserted into the list. The list is sorted by 
Outward Postcode when it is saved. 

 
Deleting 
Postcodes 

It is possible to delete a new postcode added to the list within LIS. 
 
To delete a postcode: 

 
Step Action 

1 Search for the required new postcode, or select it in the list of 
postcodes. 

2 
Click on the Delete button   
 
The selected new postcode will be deleted. 
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Viewing the Audit Log 

  
Overview The LIS application keeps a log of some of the events or operations carried 

out. Entries to the log file include the time and date of the event and a short 
description. The log file is stored in the Auditlog LIS subdirectory by default.  
 
The log file can be viewed from within LIS. The information may be useful 
for diagnosis if problems have occurred. 
 
The log can be truncated; refer to Truncating the Log (see page 61). 

   
Viewing the 
Log  

To view the log file from within the LIS: 

 
Step Action 

1 Access the Log screen.  
 
If the log is long, use the vertical scroll bar to view other 
operations at the bottom of the list. 
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Technical Information 

  
Overview You may want to look at the data stored by LIS. This is outlined in the 

section below. 

 
Looking at 
Data Stored by 
LIS 

The LIS stores data in an internal database. The database is a Microsoft 
Access file called LISData.mdb. It can be found in 
C:\LIS\Release15\1501\Data if the default directory structure is used at the 
time of installation. 
 
The file is read-only. An error message will appear if you attempt to open 
this file. You can access the database using the LIS database shortcut in 
C:\LIS\Release15\1501\. When opening the database with the shortcut type 
‘password’ in the password box. 
 
To manipulate the data held in the database, you must export the database. 
You can use the Export DB function in LIS to export the database.  
 
The export database function does not create a file that is suitable for 
transmission to the LSC.  Files sent to the LSC must be exported from 
ILR Export. 
 
The Export DB function exports data stored within the LIS programme in 
one of three formats; as a Microsoft Access 97 file (MDB format), as dBase 
III files (DBF format) or as comma separated values (CSV format).  
 
The tables exported by this option are described in the LIS Database, 
Derived Variables and Report Guidance for LIS 15.01, available on the LIS 
pages of the LSC website. You can choose to export most of the tables from 
the LIS internal database.   
 
If exporting data to a file in dBase format (.DBF file), there is an option to 
use short file names rather than long file names. This is to assist users of 
Microsoft Access, which does not appear to support use of DBF files with 
long file names. The different table names in short dbf format are listed in 
the LIS Database, Derived Variables and Report Guidance. 
 
Export the database in one of two ways: 
• using Batch Import 
• using Report Manager. 

 
Database 
Export using 
Batch Import 

To export the database using Batch Import, see the Export DB (database) 
section (see page 28). 

Continued on next page 
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Technical Information, Continued 

 
Database 
Export using 
Report 
Manager 

To export the database using Report Manager: 

 
 Step Action 

1 Access the Report Manager screen. 
2 Click on the Export DB button.  

 
The Export Database dialogue box appears. 

3 You can use the Default Export Settings or select your own: 
  IF... THEN...  
  You have the Use default 

export settings? check 
box checked 

You can select an Export 
Type from the list by 
clicking the appropriate 
radio button. Each time a 
table is exported you will be 
prompted for an Export 
Type for that table. 

 

  You uncheck the Use 
default export settings? 
check box 

The Export Type options 
are disabled and all tables 
will be exported in the same 
format. 

 

  You check the Use short 
files names for DBF 
export check box 

Short file names will be 
used in the export. 

 

  You uncheck the Use short 
files names for DBF 
export check box 

Default settings for file 
names are maintained. 

 

     
4 The export path is read-only. Click OK. 

 
Cancel will cancel the database export. 

5 A confirmation message displays after exporting the 
database. Click OK. 
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Command Line Option 

  
Overview The Command Line option allows you to run the LIS without using the LIS 

application interface. You can therefore run the LIS in the background or at a 
time more convenient to you, for instance running a large ILR data file 
overnight. When the LIS is run in this way it refers to the ‘saved defaults’ 
within the ‘Batch Import’ screen. 
 
This operation can be called from Scheduled Tasks, located in the Windows 
Control Panel. This allows you to run the operation at a specified time and 
date.  
 
Or it can be started by an MS-DOS command line prompt. This can either be 
run from the Command Prompt or saved as a text file and run immediately 
when executed from its icon. 

 
Preparing LIS to 
run the 
Command Line 
Option 

To prepare LIS to run the command line option: 

 
Step Action 

1 Launch LIS and navigate to the Batch Import screen.   
2 Select the following import options: 

• provider number and name 
• collection and type 
• Learning Aim Database 
• at least one operation. 
 
Note:  These options are mandatory and must be selected before 
attempting to run the command line option. 

3 Select any of the optional extras: 
• type of validation 
• export options 
• report options. 
 
Note:  Any files in the ‘Files selected to import’ area will be 
overwritten by the files referred to in the command line. 

4 Click the Save Defaults button. 
  IF... THEN...  
  The saved defaults are 

not set on the Batch 
Import screen 

The batch operation will not run 
and the audit log file will be 
populated with the error ‘Default 
Settings not set – LIS Batch 
Operation cancelled’. 

 

  The saved defaults 
are set on the Batch 
Import screen 

The batch operation will run 
successfully. 

 

 

Continued on next page 
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Command Line Option, Continued 

 
Step Action 

5 Exit the application. 
 
To ensure integrity of the database, LIS must be closed before 
the command line function executes. If LIS is running on your 
machine, the error ‘LIS already in use – LIS Batch Operation 
cancelled’ is written to the audit log. 

 
Viewing Error 
Messages 

When running LIS using the command line option, all error messages are 
suppressed. Suppressed error messages are written to the LIS audit log file. 
An entry is created for each operation in the audit log. 

 
Setting up a 
Scheduled 
Task  

To set up a task using the Task Scheduler follow the steps below: 

 
Step Action 

1 Run the Task Scheduler application from within the Control Panel. 
2 Select Add Scheduled Task and follow the on-screen instructions.  
3 You will need to tell the scheduler where the LIS has been 

installed; when and how often to run the LIS; and you may need 
to add your machine login details so the task runs as if it were 
started by you. 

 
Cancelling a 
Scheduled Task 

To cancel a task that is set to run at a specific time and date, follow the 
steps below: 

 
Step Action 

1 Run the Task Scheduler application from within the Control Panel. 
2 Either untick the ‘enabled’ checkbox and click on ‘Apply’, or select 

the scheduled task and chose ‘Delete’.  

 
Command Line 
Syntax 

The command line function requires three parameters: 
• the filename to import 
• the file path of the import 
• the file path of the exported LIS_exp.mdb database. 
 
The way these pieces of information are coded is as follows: 
-i <import directory> -f <filename to import> and -e <export directory> 
 
A complete piece of command line syntax would be as follows: 
C:\LIS\Release15\LIS.exe –e D:\MyExportFolder –i D:\MyImportFolder -f 
a99999500260050600201.W01 
 
Which breaks down as: 
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• ‘C:\LIS\Release15\LIS.exe’ triggers the LIS from its .exe file in the C 
drive and folders as specified 

• ‘-i D:\MyImportFolder’ tells the LIS to look in the MyImportFolder in the D 
drive for the file defined by –f 

• ‘-f a99999500260050600201.W01’ tells the LIS the name of the file to 
import 

• ‘-e D:\MyExportFolder’ tells the LIS to export the LIS_exp.mdb to the 
folder in the D drive named ‘MyExportFolder’ 

 
In addition to the above guidance: 
• If the import file path is defined by -f, for example:  -f 

D:\MyImportFolder\a99999500260050600201.W01, then the parameter 
set by -i will not be used and is therefore not necessary. 

• If no file path is stated, for  -i the last known import file path will be used 
and for -e the default LIS\Exports folder will be used. 

Continued on next page 
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Command Line Option, Continued 

  
Running an MS-
DOS Prompt 

To set up and run an MS-DOS prompt: 

 
Step Action 

1 Click Start from the task bar at the bottom of your screen. 
2 Select All Programs > Accessories > Command Prompt.  

 
The Command Prompt box displays. The prompt flashes. 

3 Type in the command line syntax. 
4 Press Enter to run the LIS operation.  
5 To stop the operation, press Cancel from the LIS Batch Import 

screen. 

 
Creating an 
MS-DOS 
Command Line 
File 

To create an MS-DOS command line in Notepad:   

 

Step Action 
1 Open a new Notepad document. 
2 Type in the command line syntax. 
3 Save as a .bat document. 
4 To run the MS-DOS code within the document, double-click the 

document icon.  
5 To edit the document, right click on the icon and select Edit. 

 


